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Experiment HE-4: Respiratory Exchange Ratio (RER)

Background

The two sources of energy available for human metabolism are carbohydrates (CHO) and fats. These 

molecules are broken down, or catabolized, into carbon dioxide, water, and energy. However, the 

oxidation of fats requires more oxygen than the oxidation of carbohydrates. 

The oxidation of a molecule of carbohydrate is expressed by the following equation:
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As shown in this equation, 6 molecules of carbon dioxide are produced for every 6 molecules of 

oxygen consumed during the oxidation of carbohydrates, a ratio of 1.0.

The oxidation of a molecule of fatty acid is expressed by this equation:
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As shown in this equation, 16 molecules of CO
2
 are produced for every 23 molecules of O

2
 consumed 

during the oxidation of fatty acids, a ratio of 0.7.

The energy requirements of the body are met with a mixture of energy derived from carbohydrates and 

fats. The activity being performed determines the proportion of carbohydrates and fats being utilized. 

At rest, a body derives about 40% of its energy from carbohydrates and 60% from fats. As the intensity 

of activity increases, the demand for energy increases, and a greater proportion of this demand is met 

by the oxidation of carbohydrates. When maximal oxygen uptake is occurring at the most intense 

exercise level, 100% of the energy is being supplied by carbohydrates because the catabolism of fat is 

too slow to supply the amount of energy required.

As the ratio of energy supplied by fats and carbohydrates shifts during changes in activity, the ratio of 

carbon dioxide produced to oxygen consumed also shifts. The ratio of carbon dioxide produced to 

oxygen consumed during cellular metabolism can be measured by determining the changes in the 

concentrations of oxygen and carbon dioxide in the air that passes into and out of the lungs. These 

measurements are possible because the amounts of oxygen and carbon dioxide exchanged between the 

alveoli and the capillaries in the lungs are directly dependent on the amounts of carbon dioxide 

produced and oxygen consumed during cellular respiration. 

The amounts of oxygen consumed and carbon dioxide produced are measured using an oxygen/carbon 

dioxide gas analyzer connected to a spirometer. The gas analyzer measures the concentration of oxygen 

and carbon dioxide in inspired and expired air, and the spirometer determines the volumes of inspired 

and expired air. When the concentrations and volumes are brought together in a series of equations, the 

volume of oxygen consumed per minute, known as VO
2
, and the volume of carbon dioxide produced 

per minute, known as VCO
2
 are determined. The ratio of VCO

2
/VO

2
 is the Respiratory Exchange 

Ratio (RER), which can be used to determine the proportion of carbohydrates and fats utilized, and the 

energy expended per liter of oxygen consumed, during an activity (Table HE-4-B1). 
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The fat and carbohydrate percentages utilized during an activity are determined using the following 

equations:

((1.00-RER)/(1.00-0.70)) x 100 = %Fat utilized

100% - %Fat utilized = %CHO utilized

The energy expended during an activity is calculated from the RER and the volume of oxygen 

consumed. For example, if the RER is 0.90, the energy expended is 4.92kcal/liter O
2
. If 2.5 liters of 

oxygen are consumed per minute for 20 minutes, a total of 246 kcal are expended during the activity:

(2.5LO
2
/minute)(20min)(4.92kcal/liter O

2
) = 246kcal 

At less intense activity levels, the rates of energy expenditure and RER values are lower. To expend the 

same amount of energy at a less intense level of activity, the duration of activity must be longer. For 

example, if the RER is 0.80, the energy expended is 4.80kcal/liter O
2
. If 1.7 liters of oxygen are 

consumed per minute, 8.16kcal are expended per minute:

(1.7LO
2
/minute)(4.80kcal/liter O

2
) = 8.16kcal/min 

To expend 246 kcal at a rate 8.16kcal/min would require 30 minutes, 9 seconds:

246 kcal/(8.16 kcal/min) = 30.15 minutes.

Table HE-4-B1: Respiratory Exchange Ratio (RER) as a Function of the Proportions of Energy 

Sources.

RER
Energy

kcal/liter O
2

% Energy from CHO % Energy from Fats

0.70 4.69 0 100

0.75 4.74 15.6 84.4

0.80 4.80 33.4 66.6

0.85 4.86 50.7 49.3

0.90 4.92 67.5 32.5

0.95 4.99 84.0 16.0

1.00 5.05 100 0
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In this experiment, students will measure the VO
2
, VCO

2
, RER, and proportion of fat and 

carbohydrates utilized while the subject was resting, hyperventilating, recovering from 

hyperventilation, and recovering from light or moderate exercise. These measurements will be 

performed quickly and easily using an iWorx GA-300 CO
2
/O

2
 gas analyzer that is connected to a 

spirometry system. 
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Experiment HE-4: Respiratory Exchange Ratio (RER)

Equipment Required

PC or Mac Computer

IXTA data acquisition unit

USB cable

IXTA power supply

Flowhead tubing

A-FH-1000 Flow head

A-GAK-201 Reusable mask and non-rebreathing valve

3ft Smooth interior tubing (35mm I.D.)

5 Liter Mixing Chamber

Gas sample tubing

GA-300 CO
2
/O

2
 gas analyzer with filter

A-CAL-150 Calibration Kit

3 Liter Calibration Syringe

Stopwatch

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in Chapter 1 for the location of the USB port and the power socket on the 

IXTA.

3. Check Figure T-1-2 in Chapter 1 for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to 

turn on the unit. Confirm that the red power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program is opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv4Complete.iwxgrp. Select this group 

and click Open.
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4. Pull down the Settings menu, again. Select the VO2-RER-GA300-LS2 settings file in 

HumanExercise-GA300.

5. After a short time, LabScribe will appear on the computer screen as configured by the VO2-

RER-GA300LS2 settings.

6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are programmed on the Preferences Dialog window which can be viewed by 

selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

Setup the Metabolic Cart

1. Locate the A-FH-1000 flowhead and air flow tubing in the iWorx kit (Figure HE-4-S1).

Note: If the expected tidal volume of the subject is less than 300 ml, use the A-FH-300 (300L flowhead) 

instead of the 1000L flowhead.

2. Carefully attache the two airflow tubes onto the two sampling outlets of the A-FH-1000 flow 

head, and the other ends of the two airflow tubes onto the two sampling inlets into the Channel 

A1 input of the IXTA.

Note: Make sure to connect the airflow tubing so that the ribbed tube is attached to the red outlet port 

of the flow head and also to the red inlet port of the spirometer. The smooth side of the tubing attaches 

to the white ports.

3. Locate the mixing chamber in the iWorx kit (Figure HE-4-S2).

4. Connect the inlet of the A-FH-1000 flow head to the outlet of the mixing chamber (Figure HE-

4-S3).

Note: Be sure to connect the flow head to the mixing chamber so that the red outlet port is facing 

towards the mixing chamber.

5. Locate the non-rebreathing valve, mask, and smooth interior tubing in the iWorx kit (Figure 

HE-4-S4).
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Figure HE-4-S1: The A-FH-1000 flowhead and the airflow tubing.

Figure HE-4-S2: The mixing chamber.

6. Attach one end of the smooth interior tubing to the inlet of the mixing chamber (Figure HE-4-

S5), and the other end to the outlet of the non-rebreathing valve. There are arrows on the valve 

that indicate the direction of air flow.

Figure HE-4-S3: The 1000L/min flowhead on the outlet of the mixing chamber.
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Figure HE-4-S4: Mask, non-rebreathing valve, and smooth interior tubing.

7. Attach the mask to the side port of the non-rebreathing valve (Figure HE-4-S4).

8. Locate GA-300 gas analyzer, the gas analyzer power supply, two sensor output cables, a gas 

inlet filter, and gas sampling tubing in the iWorx kit (Figure HE-4-S6).

Figure HE-4-S5: The spirometry circuit used to measure lung volumes during metabolic studies.

9. Position the gas analyzer on the desktop, so that the analyzer can be connected to the data 

recording unit and the mixing chamber at the same time.

10. Plug one end of the BNC-BNC cable into the CO2 output on the front panel of the GA-300 

analyzer (Figure HE-4-S6). Plug the other end of the cable into Channel A4 of the IXTA.

11. Plug one end of the DIN8-DIN8 cable into the O2 output on the front panel of the GA-300 

analyzer and the other end into Channel A5 of the IXTA.

12. Place the clear end of the nafion sampling tube on the gas sampling port near the outlet of the 

mixing chamber (Figure HE-4-S5).
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13. Place the filter on the inlet port on the rear panel of the gas analyzer (Figure HE-4-S7). Attach 

the braided end of the tubing to the filter.

14. Place the second gas sampling tube on the outlet port of the GA-300 analyzer and connect it to 

the other Luer-Lock connection on the mixing chamber.

Figure HE-4-S6: The front panel of the GA-300 gas analyzer showing the connections for CO2 and 

O2, the on/off switches, and the power adapter connection. There is also a connection for the Polar 

Heart Rate Monitor.

Figure HE-4-S7: The rear panel of the GA-300 gas analyzer with inlet ports.

15. Use the power switch to turn on the gas analyzer. As the unit powers up, the display on the front 

of the unit will light up. The gas analyzer must warm up for 30 minutes.

Note: For increased accuracy, users must complete the Flow Head Calibration procedure. Please see 

Appendix I for directions on how to perform this calibration. The calibration of the 1000L flow head 

requires a 3L Calibration Syringe.
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Load a PreSaved Flow Head Calibration (*.iwxfcd) File

Note: This procedure is used once a calibration curve has been generated using the Spirometer 

Calibration directions in Appendix I.

1. Load the lab settings file you wish to perform as stated in the “Start the Software” section.

2. Assemble the spirometer, flow head, tubing, mixing chamber and calibration syringe as shown 

in Appendix I or in the SpirometerCalibration directions.

3. Pull the plunger on the 3L Calibration Syringe all the way out until it stops (Figure HE-4-S17).

4. Click the Record button.

5. Wait for at least 10 seconds of recording so that there is no flow of air moving through the 

syringe.

6. Push the plunger in all the way until it stops. Pull the plunger out all the way until it stops.

7. Repeat the procedure in Step 6, for 5-10 repetitions, varying the speed and force on the plunger. 

No wait time is needed between strokes.

8. Wait 5 seconds after the final stroke, then click Stop.

9. On the Expired Air Volume channel, click on STPD Vol.MC (Expired Air Flow). Click SetUp 

Function to open the Spirometer Calibration dialog box (Figure HE-4-S8).

Figure HE-4-S8: Spirometer Calibration dialog window.

10. Enter these values:

• Type of flow head - Calibrated

• Click Load - a new window will open so the *.iwxfcd file that was previously generated 

can be loaded into your settings. Choose the file and click Open. The name of the 

*.iwxfcd file that was loaded will appear next to the word “Load”.
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• Atmospheric Pressure – use the built-in barometer or enter your local atmospheric 

pressure

• Temperature of Mixing Chamber (typically 25 deg C)

• Baseline use first 10 seconds as zero.

• Calibrate difference between cursors to 3 Liters

11. Move the left hand cursor to the flat line at the beginning of the calibration recording.

12. Move the right hand cursor to the flat line at the end of the calibration recording.

13. Click Calibrate difference between cursors to so that the calibration curve for this experiment is 

generated.

14. Click OK.

15. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.

Calibrating the GA-300 Gas Analyzer

Calibrate the O
2
 and CO

2
 Channels 

Note: Warm up the GA-300 for at least 30 minutes prior to use.

The outputs of the oxygen and carbon dioxide sensors of the GA-300 are voltages that are proportional 

to the concentrations of the gases being measured by the analyzer. To determine the volumes of oxygen 

consumed and carbon dioxide produced during metabolic testing, the voltage outputs of the sensors 

need to be converted, by the recording software, to the percentages of these gases in the inhaled and 

exhaled air. 

To make this conversion, samples of two different concentrations of oxygen, and two different 

concentrations of carbon dioxide, will need to be put into the GA-300 gas analyzer as the voltage 

outputs of each sensor are recorded. 

One set of samples can be taken from room air, which contains 20.93% O
2
 and 0.04% CO

2
. The other 

set of samples can be taken from gas cylinders containing a combination of these two gases at different 

concentrations. Cylinders containing both oxygen and carbon dioxide are readily available from 

suppliers. Some of the most commonly used combinations contain:

• 12% O
2
 and 5% CO

2
, with the balance being N

2,
 or;

• 16% O
2
 and 4% CO

2
, with the balance being N

2
.

Record the Voltage Outputs of the Gas Sensors

1. Reminder - turn on the GA-300 for at least 30 minutes before performing a calibration.

2. Prepare the equipment that will deliver any gas samples, other than room air, to the GA-300:
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• Clamp and secure any gas cylinders that will be used to provide gas samples near the 

GA-300 gas analyzer.

• Attach the regulator to the gas cylinder safely. 

• Attach a Luer-Lock connector to the outlet of the regulator that will allow the 

Calibration Kit for the GA-300 to be connected to the regulator of the gas cylinder.

• Open the primary and secondary valves of the regulator for a few seconds to purge the 

air from the regulator.

• Close the secondary valve on the regulator to stop the flow of gas from the regulator. 

You will only need the cylinder for the second sample of gas.

3. Attach a filter to the inlet port on the front of the GA-300 analyzer. Attach the braided end of 

the sampling tubing to the inlet of the filter.

4. Measure the voltage outputs of the oxygen and carbon dioxide sensors when measuring a 

sample of room air.

5. Place the gas sampling tubing away from the users to prevent the sampling of exhaled air. 

Allow room air to be pumped through the gas analyzer for about 10 seconds before recording 

the outputs of the sensors.

• Type “Room Air” in the Mark box to the right of the Mark button.

• Click on the Record button. The recording should scroll across the screen.

• While recording, press the Enter key on the keyboard to mark the recording for the room 

air gas sample. 

• Record the outputs of the two gas sensors for about ten seconds or until the recording 

levels out. The recording should be like the first segment of data in Figure HE-4-S11.

• Continue to record while moving to the next series of steps.

6. Measure the voltage outputs of the oxygen and carbon dioxide sensors for a second sample of a 

gas mixture containing known concentrations of oxygen and carbon dioxide.

• Open the secondary valve on the regulator of the cylinder providing the second gas 

sample. Adjust the flow rate to low.

• While the gas sample is flowing from the regulator, connect the gas sample tubing of the 

A-CAL-150 Calibration Kit (Figure HE-4-S9) to the Luer-Lock connector on the output 

of the regulator. 

• Connect the outlet from the A-CAL-150 Calibration Kit to the inlet filter port on the 

front of the GA-300. The GA-300 will pull the air in from the calibration kit (Figure HE-

4-S10).

• Type Known Gas in the Mark box.

• While continuing to record with the sample gas flowing into the GA-300, press the Enter 

key on the keyboard to mark the recording for the known gas sample. 
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Figure HE-4-S9: Calibration Kit A-CAL-150

Figure HE-4-S10: A-CAL-150 attached to the rear of the GA-300 gas analyzer.

7. Once the recordings of the gas concentrations reach a steady level, record for another ten 

seconds. 

8. This can take up to 30 seconds or so.

9. Click the Stop button.

10. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.

Convert the Units on Gas Concentration Channels

1. Use the Display Time icons (Figure HE-4-S12) to adjust the Display Time of the Main window 

to show the complete calibration data on the Main window at the same time. The required data 

can also be selected by:

• Placing the cursors on either side of data required.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the entire 

segment of data to the width of the Main window.
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2. Click the DoubleCursor icon so that two blue cursors appear on the Main window. Place one 

cursor on the section of data recorded when gas analyzer was collecting a sample of room air 

and the second cursor on the section of data recorded when the second sample was collected.

3. Convert the voltages at the positions of the cursors to concentrations using the Advanced Units 

Conversion dialogue window (Figure HE-4-S13).

4. To convert the voltages on the Expired CO2 Concentration (%) channel, click on the arrow to 

the left of the carbon dioxide channel to open the channel menu. Select Units from the channel 

menu, and select Advanced from the submenu.

5. On the Units Conversion window:

• Make sure Apply units to the next recorded block and Apply units to all blocks are 

selected in the menu under the displayed graph on the left side of the window by putting 

a check mark in the boxes next to each statement. 

• Click on and move the cursors so that they are in position such that:

• the first 2 cursors are on the area where room air was recorded. Leave a space 

between the cursors so that you have an average value being calculated while 

room air was moving into the GA-300 gas analyzer.

• the second 2 cursors are on the area where the known gas sample was recorded. 

Leave a space between the cursors so that you have an average value being 

calculated while the gas sample was moving into the GA-300 gas analyzer.

Figure HE-4-S11: The voltage outputs of the two sensors in the GA-300 gas analyzer, carbon dioxide 

on the top and oxygen on the bottom. Other recording windows have been minimized to show detail.
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Figure HE-4-S12: The LabScribe2 toolbar.

Figure HE-4-S13: The Advanced Units Conversion dialogue window with the voltages between the 

cursors set to equal the concentrations used in calibration.

• Notice that the voltages from the positions between the cursors are automatically entered 

into the value equations. Enter the two concentrations of carbon dioxide measured from 

the two samples in the corresponding boxes on the right side of the conversion 

equations. 

• Room air concentration of CO2 = 0.04

• The second gas concentration will be the known one from the gas cylinder. 

Generally a 5% CO
2 

concentration is recommended.

• Enter the name of the units, %, in box below the concentrations.

• Click the OK button in the lower right corner of the window.
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6. Repeat Steps 4 and 5 on the Expired O2 Concentration (%) channel.

• Room air = 20.9

• Second gas concentration will be the known one from the gas cylinder. Generally a 12% 

O
2 

concentration is recommended.

7. Click on the Save button.

Appendix I: Initial Spirometer Flow Head Calibration

For accuracy of measurements, users must include this calibration procedure as part of the 

Exercise Physiology Lab protocol. 

It is suggested that this procedure be followed at the beginning of every term and when using a new 

flow head-spirometer combination.

Note: This calibration protocol precedes the actual calibration of the GA-200 or GA-300 gas analyzer. 

You will not need the gas analyzer at this time.

Note: Whenever you will be using a different flow head, you will need to repeat this calibration 

procedure from the beginning by loading a new Spirometer Calibration settings file. 

1. Open the LabScribe software.

2. Click Settings - Human Exercise (GA200 or GA300). Choose SpirometerCalibration-LS2 to 

launch the calibration settings file.

3. Assemble the spirometer, flow head, tubing, mixing chamber and calibration syringe.

4. Plug the SP-304 spirometer into the correct channel for the iWorx recording device.

• IX/214 - Plug the SP-304 spirometer into channel 4.

• IXTA – Plug the tubing into the spirometer channel A1.

• IX/228 - Plug the SP-304 spirometer into channel 6.

• Connect the flow head to the spirometer using the white or gray flow head tubing, 

making sure that the ribbed side of the tubing connects the red marked port on the flow 

head to the red marked port on the spirometer (Figure HE-4-S14).

• Connect the smooth side of the tubing to the other ports.

5. Connect end of the1000L flow head with the red marked onto white flange of the mixing 

chamber. Make sure the tubing is in an upright direction (Figure HE-4-S15).

Note: Make sure the red port on the flow head faces into the mixing chamber.

6. Connect one end of the smooth bore tubing to the 3L calibration syringe as shown in Figure 

HE-4-S17.
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Figure HE-4-S14: The 1000L flow head and airflow tubing. 

Figure HE-4-S15: The 1000L flow head attached to the mixing chamber showing the tubing in an 

upright position and the red port facing the mixing chamber.

Figure HE-4-S16: 1000L flow head connected to the mixing chamber, showing the nafion tubing 

connected to the outlet sampling port near the flow head.

7. Connect the other end of the smooth bore tubing to the mixing chamber, opposite the flow head 

(Figure HE-4-S18).
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8. If also setting up the gas analyzer at this time:

• Connect the braided nafion tubing to the filter on the gas analyzer and to the flow head 

side of the mixing chamber. Make sure the braided end is connected to the filter (Figure 

HE-4-S16).

• Connect the thin flexible tubing from the outlet of the gas analyzer to the port next to the 

smooth bore tubing on the opposite side of the mixing chamber (Figure HE-4-S18).

Figure HE-4-S17: 3 liter calibration syringe connected to the smooth bore tubing.

Figure HE-4-S18: The smooth bore tubing connected to the mixing chamber.

9. If not using the gas analyzer at this time, connect the flexible tubing from the port on one side 

of the mixing chamber to the port on the other. This ensures there is no air leaking from the 

chamber.

10. Pull the plunger on the 3L Calibration Syringe all the way out until it stops.

11. Click the Record button.

12. Wait for at least 10 seconds of recording so that there is no flow of air moving through the 

syringe.

13. Push the plunger in all the way until it stops. Pull the plunger out all the way until it stops.
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14. Repeat the procedure in Step 13, for at least 50 repetitions, varying the speed and force on the 

plunger. No wait time is needed between strokes.

15. The faster the speed of the stroke, the higher the flow through the calibration syringe.

Note: Ideally the flow head calibration recording should span air flow values to include the minimum 

to maximum flow levels for the particular experiment being conducted.

16. After at least 50 repetitions have been performed, wait at least 5 seconds after the final 

repetition and then click Stop.

17. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, such as your desktop or other location). Designate the file type as 

*.iwxdata. 

18. Click on the Save button to save the raw data for generation of a flow head calibration *iwxfcd 

file.

19. Click AutoScale on the Air Flow channel. 

20. Use the Display Time icons to adjust the Display Time of the Main window to show the 

complete calibration data (Figure HE-4-S19). 

21. Click the Double Cursor icon so that two blue cursors appear on the Main window. 

Figure HE-4-S19: The LabScribe2 toolbar.

22. Click Advanced on the main toolbar. Then click Metabolic, and Calibrate FlowHead (Figure 

HE-4-S20).

23. Place the two blue vertical cursors so that:

• The left-hand most cursor is on the flat line prior to the start of the calibration data. 

Make sure the cursor is at the beginning of the 10 second baseline.

• The right-hand most cursor is on the flat line after the final calibration stroke (Figure 

HE-4-S21).
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Figure HE-4-S20: Calibrate FlowHead dialog window.

24. In the new window that opens (Figure HE-4-S22), enter these values:

• Flow channel = Expired Air Flow

• Baseline = Use the first 10 seconds as zero

• Calibrate difference between cursors to 3 L

Figure HE-4-S21: The calibration recording showing the blue vertical cursors in the correct position 

for generating a calibration curve.
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25. Click the Calibrate the difference between cursors to button. This will generate the curve as 

shown in Figure HE-4-S22.

Figure HE-4-S22: Calibration syringe data. 

26. A new window will open prompting you to Save your file as an *.iwxfcd flow head calibration 

file. Name your file and click Save.

27. Click OK.

Note: At this point, a raw calibration data file (*.iwxdata) and a flow head calibration file (*.iwxfcd) 

have been generated.

28. Exit LabScribe or open a Human Exercise lab settings file.

29. Once a saved *.iwxfcd file is loaded - a simple 5-10 stroke calibration procedure can be used to 

update the file for immediate use.
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Experiment HE-4: Respiratory Exchange Ratio (RER)

Before Starting

1. Read the procedures for the experiment completely before beginning the experiment. Have a 

good understanding of how to perform the experiment before making recordings.

2. It is important that the subject is healthy and has no history of respiratory or cardiovascular 

problems.

3. Allow the SP-304 to warm up for 15 minutes before recording for the first time. 

4. Determine if the airflow tubes between the flowhead to the spirometer amplifier are attached to 

the proper inlets on each device. 

• Since this test does not need to be recorded, click on the Save to Disk button in the lower 

left corner of the Main window. If LabScribe is in Preview mode, there will be a red X 

across the Save to Disk button.

• Click on the Preview button.

Note: If the user clicks the Preview button and an error window appears the Main window indicating 

the iWorx hardware cannot be found, make sure the iWorx unit is turned on and connected to the USB 

port of the computer. Then, click on the OK button in the error window. Pull down the LabScribe Tools 

menu, select the Find Hardware function, and follow the directions on the Find Hardware dialogue 

window

• Have the subject inhale and exhale through the mask 2 or 3 times while the complete 

spirometry circuit is assembled. 

• Click on the AutoScale button at the upper margin of the Expired Air Flow and Lung 

Volume channels.

• If the proper end of the flowhead is attached to the outlet of the mixing chamber, the 

traces on the Air Flow and Lung Volume channels will go up when the subject exhales. 

• If the traces on these channels go down during exhalation, remove the flowhead from the 

outlet of the mixing chamber and place the other end of the flowhead on the outlet of the 

mixing chamber.

• Click on the Stop button. 

5. Click on the Save to Disk button, in the lower left corner of the Main window, to change 

LabScribe from Preview mode to Record mode. If LabScribe is in Record mode, there will be a 

green arrow on the Save to Disk button.
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Exercise 1: VCO
2
, VO

2
, and RER at Rest 

Aim: To determine the effect of breathing at rest on VCO
2
, VO

2
, and RER.

Procedure

1. Instruct the subject to sit quietly, become accustomed to breathing through the spirometry 

equipment, and breathe normally before any recordings are made. 

2. Remove the flowhead from the end of the outlet of the mixing chamber.

3. Type <Subject’s Name> Inhalation at Rest in the Mark box that is to the right of the Mark 

button. 

4. Click on the Record button. After waiting five seconds for the Lung Volume STPD channel to 

zero, connect the proper end of the flowhead to the outlet of the mixing chamber. Press the 

Enter key on the keyboard to mark the recording.

Note: The LabScribe software will zero the Lung Volume STPD channel during the first five seconds of 

recording. No air should be moving through the flowhead during this time.

5. Click the AutoScale buttons on all channels.

6. On the Expired CO2 Concentration (%) channel, notice that the CO
2
 concentration increases in 

the first few minutes of the recording and then reaches a near-steady level.

• The time that it takes the chamber to be filled with expired air and reach a near-steady 

level of carbon dioxide is dependent on the tidal volume and respiration rate of the 

subject and the volume of the mixing chamber. It will take longer to fill the chamber if 

the subject’s respiration rate and tidal volume are low, or the chamber is large.

• Every breath exhaled into the mixing chamber pushes a matching volume of expired air 

out of the mixing chamber.

• Record baseline data, while the mixing chamber air is replaced with the subject’s 

expired air, for approximately 5-10 minutes prior to beginning any experiments.

7. On the Expired O2 Concentration (%) channel, notice that the O
2
 concentration decreases in the 

first few minutes of the recording and then stays a near-steady level. As pointed out in the 

previous step, the size of the mixing chamber, the tidal volume, and respiration rate of the 

subject, determine the time it takes for the concentration of oxygen in expired air to reach that 

near-steady level.

8. On the Lung Volume channel, the STPD Volume-MC spirometry function converts the data 

from the Air Flow channel to the volumes of expired air at STPD. Notice that the recorded 

volume increases in a ramp-like manner with each breath.

9. On the Absolute VCO2 channel, an equation programmed in the Channel Math function 

determines the volume of carbon dioxide produced during the exercise. The volume of carbon 

dioxide produced in a minute is the parameter known as VCO
2
. 
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10. On the Absolute VO2 channel, an equation programmed in the Channel Math function 

determines the volume of oxygen consumed during the exercise. The volume of oxygen 

consumed in a minute is the parameter known as VO
2
.

11. Continue to record until one or more minutes of data are recorded while the concentrations of 

oxygen and carbon dioxide in expired air are at a steady level. Once the appropriate duration of 

data is recorded, click Stop to halt the recording. Your recording should be similar to the data 

displayed in Figure HE-4-L1.

12. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.

Data Analysis

1. Display the complete data recording in the Main window. Use the Display Time icons to adjust 

the Display Time of the Main window to show the complete recording on the Main window. 

2. Select and display a 60-second section of the recording while the oxygen and carbon dioxide 

concentrations were at a steady level on the Main window. Select the 60-second section of the 

recording by:

• Placing the cursors on either side of the 60-second section of data; and,

• Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HE-4-L2) to expand the 

selected section of data to the width of the Main window.

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window (Figure HE-4-L3).

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 

window. The functions, V2-V1, T2-T1, and Mean, should appear in this table. Values for these 

parameters on each channel are seen in the table across the top margin of each channel.

5. Once the cursors are placed in the correct positions for determining the CO
2
 and O

2
 

concentrations in expired air, the Lung Volumes at STPD, the VCO
2
, and the VO

2
 of the resting 

subject, the values for these parameters can be recorded in the on-line notebook of LabScribe by 

typing their names and values directly into the Journal.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter 

the names and values of these parameters in the Journal. To use them:

• Place the cursors at the locations used to measure the concentrations and volumes.

• Transfer the names of the mathematical functions used to determine these concentrations 

and volumes to the Journal using the Add Title to Journal function in the VCO2 Channel 

pull-down menu.

• Transfer the values for the volumes and rates to the Journal using the Add All Data to 

Journal function in the VCO2 Channel pull-down menu.
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Figure HE-4-L1: Gas concentrations and volumes of a standing subject displayed on the Main window.  

Concentrations of gases reach a steady state after the mixing chamber is filled. Cursors placed one 

minute apart indicate VCO
2
 is 0.302 liters and VO

2
 is 0.337 liters. Therefore, RER is 0.90.

Figure HE-4-L2: The LabScribe toolbar.

7. Use the mouse to click on and drag the cursors to positions on the Expired O2 Concentration 

(%) channel that are one minute apart during the near-steady level of oxygen in the mixing 

chamber (Figure HE-4-16 on page HE-4-10). The values for the following parameters are 

determined when the cursors are positioned as directed:

• Mean concentration of CO
2
 in expired air, which is the value for Mean on the Expired 

CO2 Concentration channel.

• Mean concentration of O
2
 in expired air, which is the value for Mean on the Expired O2 

Human Exercise – VO2-RER-GA300 – Background HE-4-24



Concentration channel.

• Lung Volume at STPD expired in a minute, which is the value for V2-V1 on the Lung 

Volume STPD channel.

• Volume of carbon dioxide produced in one minute (VCO
2
), which is the value for V2-

V1 on the VCO2 channel.

• Volume of oxygen consumed in one minute (VO
2
), which is the value for V2-V1 on the 

VO2 channel.

Figure HE-4-L3: The oxygen and carbon dioxide concentrations, air flow, lung volumes STPD, VCO2, 

and VO2 recorded form a resting subject as displayed in the Analysis window.

8. Record the values in the Journal using one of the techniques described in Steps 6 or 7.

9. Record the values for the mean CO
2
 and O

2
 concentrations in expired air, the Lung Volume at 

STPD, the VCO
2
, and the VO

2
 while the subject was resting in Table HE-4-L1.

10. Calculate the Respiratory Exchange Ratio (RER) of the resting subject by dividing the value for 

VCO
2
 by the value for VO

2
. Record the values for RER in Table HE-4-L1.
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Exercise 2: Effect of Hyperventilation on VCO
2
, VO

2
, and RER

Aim: To measure the effect of deep breathing on VCO
2
, VO

2
, and RER during and after the period of 

hyperventilation.

Procedure

1. Use the same procedures used in Exercise 1 to record the lung volumes from the subject while 

the gas concentrations are reaching a steady state, while the subject is hyperventilating for a 

minute, and while the subject is recovering from hyperventilation.

2. Mark the recording with comments that indicate the name of the subject and the beginning of 

the three periods being recorded.

3. The subject should breathe normally as his or her expired air is filling the mixing chamber. 

During this period of time, the concentrations of oxygen and carbon dioxide in the chamber are 

nearing a steady level.Once the concentrations of oxygen and carbon dioxide have reached 

steady levels, the subject should begin hyperventilating so that his or her inhalation volume at 

least 3 times the resting tidal volume (Figure HE-4-L4). Mark the recording with a comment to 

indicate the beginning of the period of hyperventilation.

4. The subject should hyperventilate for at least one minute. If the subject cannot hyperventilate 

for one minute because he or she is feeling dizzy, the subject should return to breathing 

normally. The subject does not need to complete a full minute of hyperventilation. The volumes 

recorded during hyperventilation can be prorated to provide minute volumes.

5. After the period of hyperventilation, the subject should return to breathing normally. Mark the 

recording with a comment to indicate the beginning of the recovery period.

Data Analysis

1. Use the same procedures used in Exercise 1 to determine the minute volumes of expired air at 

STPD, oxygen consumed (VO
2
), carbon dioxide produced (VCO

2
), and respiratory exchange 

ratio (RER) during the hyperventilation and recovery from hyperventilation when the gas 

concentrations were at steady levels.

2. If the concentrations of oxygen and carbon dioxide were at a steady level for less than a minute, 

prorate volumes to minute volumes. For example, if the oxygen and carbon dioxide 

concentrations reached a steady level for 30 seconds during hyperventilation, the measured 

volumes are converted to minute volumes by multiplying the 30-second values by 2.

3. Record the values for the mean CO
2
 and O

2
 concentrations in expired air, the minute volume of 

expired air at STPD, the VCO
2
, and the VO

2
 for the periods of steady gas concentrations during 

hyperventilation and recovery from hyperventilation on Table HE-4-L1.

4. Calculate the Respiratory Exchange Ratio (RER) for the period when the subject was 

hyperventilating by dividing the value for VCO
2
 by the value for VO

2
 for the period. Record 

the value of the RER in the data table. Repeat the RER calculation for recovery period after 

hyperventilation.
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Table HE-4-L1: VCO
2
, VO

2
 and the Respiratory Exchange Ratio (RER) of a Subject at Rest, 

Hyperventilating, and Recovering from Exercise.

Environmental 

Conditions

Experimental

Periods

Concentration 

(%) in Expired 

Air
Lung 

Volume 

(STPD)

Volume of 

CO
2
 

Produced

(VCO
2
)

Volume of 

O
2
 

Consumed(

VO
2
)

RER

CO
2

O
2

Temperature

(oC)

Resting

[Gas] Steady

Hyperventilation

[Gas] Steady

Barometric 

Pressure 

(mmHg)

1st Minute After 

Hyperventilation

First Minute 

After Exercise

Relative 

Humidity (%)

Second Minute 

After Exercise

Third Minute 

After Exercise

Exercise 3: Effect of Moderate Exercise on VCO
2
, VO

2
, and RER

Aim: To measure the effects of moderate exercise on VCO
2
, VO

2
, and RER during the recovery period.

Procedure

1. Use the same procedures used in Exercise 1 to record the lung volumes from the subject during 

the first, second, and third minutes of recovery from exercise.

2. Mark the recording with comments that indicate the name of the subject and the beginning of 

each minute being recorded.

Data Analysis

1. Use the same procedures used in Exercise 1 to determine the minute volumes of expired air, 

oxygen consumed (VO
2
), carbon dioxide produced (VCO

2
), and respiratory exchange ratio 

(RER) during the first, second, and third minutes of recovery.

2. Record the values for the mean CO
2
 and O

2
 concentrations in expired air, the minute volume of 

expired air at STPD, the VCO
2
, and the VO

2
 for each minute of recovery on Table HE-4-L1.
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3. Calculate the Respiratory Exchange Ratio (RER) for each minute of recovery by dividing the 

value for VCO
2
 by the value for VO

2
 for that period. Record the values for RER in the data 

table.

Figure HE-4-L4: Recording of gas concentrations and lung volumes from a hyperventilating subject. 

Hyperventilation is followed by the recovery period.

Questions

1. During which experimental period was the subject’s VCO
2
 the highest? In which period was it 

the lowest?

2. During which period was the subject’s VO
2
 the highest? In which period was it the lowest?

3. During which period did the subject have the highest RER? In which period was the RER the 

lowest?

4. Evaluate the physical fitness of your subject. How does the level of your subject’s physical 

fitness correlate to his or her RER at rest? While hyperventilating? While recovering from 

exercise?

5. Evaluate the diet of your subject. How does your subject’s diet correlate to his or her RER at 

rest? While hyperventilating? While recovering from exercise?
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6. How does your subject’s level of physical fitness, diet, and RER correlate to those parameters 

from other members of the class?

Optional: Calculate and Plot Metabolic Parameters

Values for VO
2
, VCO

2
, RER, TV, and other parameters (Table HE-4-L2) from the segments of the test 

can be calculated automatically by using the Metabolic Calculations window. 

1. To use the Metabolic Calculations window, pull down the Advanced menu and select Metabolic. 

Select Mixing Chamber: Offline Calculations from the submenu to open the Metabolic 

Calculations Dialog window.

2. On the left side of the Metabolic Calculations window:

• Pull down the CO2, O2, Volume, Heart Rate, and Energy Channel menus to select the 

channels on which the CO
2
 and O

2
 concentrations, lung volumes, heart rates, and 

workload were recorded.

• When analyzed, the data file will be divided into time segments. The average of each 

parameter in each segment will be reported in the data table on the Metabolic Calcula-

tions window. Enter the time (in secs) in the Average box to select the time length of 

each segment.

• In the O
2
 and CO

2
 Concentrations in Inhaled Air boxes, enter the concentrations of 

oxygen and carbon dioxide in the inhaled air, which is room air in most tests.

3. Click on the Calculate button on the left side of the Metabolic Calculations Dialog window to 

calculate the average value of each parameter listed in the table for each time segment of the 

recorded data, and to plot the selected parameters against each other in the plot panel (Figure 

HE-4-L5).

4. In the lower left corner of the plot panel, click on the arrow to open the pull-down menu listing 

the types of plots (Table HE-4-L3) that can be made with the metabolic parameters calculated 

by this analytical tool. Select the plot to be displayed in the plot panel when the calculations are 

performed.
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Table HE-4-L2: List of Parameters Calculated on the Breath By Breath Offline Metabolic 

Window

Term Parameter Description Units

Abs.VO
2

Absolute VO
2 Volume of oxygen (O2) consumed / minute Liters/minute

Abs.VCO
2

Absolute VCO
2

Volume of carbon dioxide (CO2) produced 

per minute
Liters/minute

Rel.VO
2

Relative VO
2

Volume of O2 consumed per kg body weight 

per minute
ml/kg/minute

Rel.VCO
2

Relative VCO
2

Volume of CO2 produced per kg body 

weight per minute
ml/kg/minute

RER
Respiratory 

Exchange Ratio
Ratio of VCO

2
/VO

2 None

REE
Resting Energy 

Expenditure

5.46 (Absolute VO
2
) + 1.75 (Absolute 

VCO
2
)

kcal/day

TV Tidal Volume
Volume of air displaced during a normal 

breath cycle - inhalation and exhalation
Liters/breath

RR Respiratory Rate
Number of breaths per minute; divide 

(60 sec/min) by (sec/breath)
Breaths/minute

METS
Metabolic 

Equivalent of Task
1 MET = 3.5ml O

2
/kg/min or 1kcal/kg/hr MET

O
2 

Min. O2 Minimum - 

exhalation

Minimum concentration of O2 recorded 

during test period
Percentage

CO
2 

Max. CO2 Maximum - 

exhalation

Maximum concentration of CO2 recorded 

during test period
Percentage

VI
Inspired Tidal 

Volume

Volume of air displaced during normal 

inhalation 
Liters/breath

VE
Expired Tidal 

Volume

Volume of air displaced during normal 

exhalation
Liters/breath

P Power Workload during the stages of the test Watts

HR Heart Rate
Number of beats in a minute - divide 

(60 sec/min) by the beat period (sec/breath)
Beats/minute
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Table HE-4-L3: Plots Available on the Offline Metabolic Window.

Available Plots

Y-Axis 

Parameter 1
VO

2
VCO

2
V

e
V

e HR V
t

V
e HR VO

2

V
e
/VO

2

RER

Y-Axis 

Parameter 2
VCO

2
VCO

2

VO
2
/

HR
VCO

2

V
e
/VC

O
2

Y-Axis 

Parameter 3
RER

X-Axis 

Parameter
Time VO

2
VO

2
VCO

2
VO

2
V

e Watts Watts Watts Watts Watts
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Figure HE-4-L5: The metabolic parameters, and plots of VO
2
, VCO

2
, and RER vs. Time, displayed in 

the Metabolic Calculations window used offline to analyze data collected during an aerobic fitness 

test. Notice that the VO
2
 and VCO

2
 values increase quickly as the subject performs more strenuous 

segments of the test.
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